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Introduction 
A primary enhancement of SAS IT Resource Management 3.1.1 is the incorporation of 

world-class reporting and report distribution capabilities available from SAS.  In 
previous releases, the SAS IT Resource Management Solution relied upon a custom 
reporting interface to perform the following tasks: 

 Define and set report options. 
 Generate a specific set of report types. 
 Summarize data by time periods specified at report generation time.  

Now, SAS Business Intelligence is not only delivered by the IT organization, it 
enables the IT organization to deliver IT performance management and capacity 
planning for the corporate IT enterprise. 

SAS Enterprise Guide has long been available to SAS IT Resource Management 
customers as a reporting tool option.  Beginning with SAS IT Resource Management 
3.1.1, SAS Enterprise Guide is the primary reporting tool for the SAS IT Resource 
Management solution.   

This document provides a guideline for converting reports that are generated by the 
SAS IT Resource Management 2.7 reporting tools to new and enhanced reports using 
SAS IT Resource Management 3.1.1 and the SAS Enterprise Guide reporting tool.  

Reporting with SAS IT Resource Management 2.7 and reporting with SAS IT 
Resource Management 3.1.1 using SAS Enterprise Guide have some similarities:  

 Both reporting tools provide an interface that enables a user to generate reports 
quickly and easily without requiring SAS programming skills.  

 Both reporting tools enable users to write and submit SAS code to generate 
reports.  

 Both reporting tools support a variety of SAS graph types and options.  
 Both reporting tools generate the SAS code necessary to create the desired 

reports. 

C H A P T E R  C H A P T E R  
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However, there are differences between the SAS IT Resource Management 2.7 
reporting tool and using SAS Enterprise Guide to generate reports in SAS IT Resource 
Management 3.1.1: 

 The SAS IT Resource Management 2.7 reporting tool relies upon the existence of 
custom SAS IT Resource Management 3.1.1 report macros that are delivered 
with the solution.  SAS Enterprise Guide does not. 

 SAS Enterprise Guide delivers a user friendly interface from which a significant 
set of report tasks and task options are selected compared to the SAS IT Resource 
Management 2.7 user interface for report generation.   

 SAS Enterprise Guide supports a much larger set of report types and options 
than the report types and options that are supported by SAS IT Resource 
Management 2.7 report macros.  It also offers many data management and 
analytical procedures that are not available in SAS IT Resource Management 2.7. 

 A set of SAS IT Resource Management 2.7 reports are not yet available in SAS IT 
Resource Management 3.1.1 using SAS Enterprise Guide. These reports are 
listed in the following table.  

Table 1.1 Status of SAS IT Resource Management 2.7 Report Types 

Report Types Status 

Spectrum Plot Replaced with a new Tile Chart available in a future 
release of SAS Enterprise Guide. 

Tile Chart Available in a future release of SAS Enterprise 
Guide. 

Gallery Today, you can use SAS Enterprise Guide to publish 
reports to the Web. 

Exception Reports Today, limited exception reporting can be 
accomplished by using filters to subset data for top 
or low values of a given ranked column. 

In addition to the differences shown in the preceding table, SAS Enterprise Guide 
supports reporting from data accessible via information maps. Using information maps 
is the recommended method for accessing your data in SAS IT Resource Management 
3.1.1. 

The following table shows the SAS IT Resource Management 2.7 macros and the 
equivalent SAS Enterprise Guide tasks that should be used to generate equivalent 
reports.  Much of the existing functionality that is available through SAS IT Resource 
Management 2.7 reporting macros is provided by SAS Enterprise Guide. 

Table 1.2 SAS Enterprise Guide Report Tasks for SAS IT Resource Management 2.7 Report Macros 

SAS IT Resource 
Management 2.7 Report 
Macro 

Corresponding SAS Enterprise Guide 
Report Task or Feature That Is Used to 
Recreate the Report 

%CPCHART   Bar chart and pie chart tasks 

%CPCCHRT Bar chart and pie chart tasks 

%CPPLOT1 Line plot, scatter plot, area plot, and box plot 
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SAS IT Resource 
Management 2.7 Report 
Macro 

Corresponding SAS Enterprise Guide 
Report Task or Feature That Is Used to 
Recreate the Report 

tasks 

%CPPLOT2 Line plot task 

%CPTABRPT Summary tables task 

%CPPRINT List data task 

%CPSRCRPT Code window task 

%CPG3D Scatter plot task 

%CPGTPLT Document builder feature 

%CPSETHAX SAS Enterprise Guide report option for 
selected reports 

%CPIDTOPN Filter and ranked column  

%CPRUNRPT Stored process feature 

%CPSPEC Tile chart in a future SAS Enterprise Guide 
release  

%CPEXCEPT Web publishing feature 

%CPHTREE Web publishing feature 

%CPMANRPT Web publishing feature 

%CPWEBINI web publishing feature 

%CPXHTML Web publishing feature 

%CPENTCPY Obsolete 

Refer to the next sections for more detail on creating specific reports and setting 
report task options using SAS Enterprise Guide. 

Global and Individual Report Tasks and Options 
To create reports with SAS Enterprise Guide, select the report task that is associated 

with the report that you want to create and set the report options. You can set report 
options in one of the following two ways:  

 Set global options in the Options window. These options apply to all tasks in the 
SAS Enterprise Guide project.  

 Set options in each individual report task.  

The report options and their respective functions are labeled clearly. Report tasks 
with similar options use similar Options windows. 

Global Report Task Options 
In SAS Enterprise Guide, there are a few report task options that can be set for all 

report tasks in your project. The following list shows some of the global options you can 
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set. To set an option, select Tools > Options from the menu bar. Then, on the left hand 
pane of the Options window, click on the string that is specified in parentheses. 

 graph format type, such as GIF or ActiveX (Graph) 
 graph width and height  (Graph) 
 report title and footnote (Tasks General) 
 view report output, with tools such as SAS Enterprise Guide or your local 

browser (Viewer)  
 other options using Custom Code (Custom Code) 

Global Pattern and Symbol Options Using Custom Code 
In SAS Enterprise Guide, pattern and symbol options are typically set at the 

individual report task level. However, you can set these options once for the entire 
project using the Insert custom SAS code option. Global options can be set using this 
method and can still be overridden in an individual report task for a specific task. 

To set global graph options, perform the following steps: 

1 Select Tools >Options from the menu bar. 

2 Click on Custom Code in the left hand pane, and check the Insert custom SAS 
code before task and query code box. 

3 Click Edit. 

4 Type the desired graph option statements in the Edit window.  

5 Click Save and OK to save the change. 

6 Rerun your report task to use the new graph option statements. 

Individual Report Task Options 
Most report task options are set individually by specifying values for each report task. 

To set values for the report task options in an individual report task, perform the 
following steps:  

1 Open the report task for which an option is to be set. 

2 Select the appropriate window under the Appearance category for the task. 

3 Select from the various options or specify a valid value for the desired option. 

Click Help to view the Help on any specific option in the current window. 

Top N and Bottom N Reporting 
In SAS IT Resource Management 2.7, some report types support the Top N and 

Bottom N reporting option. For other report types, the use of the macro %CPIDTOPN is 
required.  

To report on the top or bottom contributors for a specific column in SAS IT Resource 
Management 3.1.1 using SAS Enterprise Guide, you can use a filter to select the top or 
bottom contributors for a specific ranked column. Information map filters can be defined 
(using the SAS IT Resource Management Plug In to SAS Data Integration Studio 
Information Map transformation or using Information Map Studio) and selected in the 
Filter tab of the Information map window in SAS Enterprise Guide. Filters can also be 
specified within SAS Enterprise Guide Query tasks. 
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Report Output 
In SAS Enterprise Guide you can generate graph output to the SAS Enterprise Guide 

window or to a local browser. You can specify your preference by selecting Tools > 
Options from the menu bar. You can also generate graph output by publishing to a Web 
server or to a file system. You can use SAS Management Console to define channels and 
then select a channel when publishing from SAS Enterprise Guide. In addition, if you 
use the SAS Report format, a report can be published to a repository and SAS Web 
Report Studio. For more information about publishing SAS Enterprise Guide reports, 
see SAS Enterprise Guide help. 

Print a Report 
To print a report from the SAS Enterprise Guide window select File > Print from the 

drop-down menu. You can also right-click on the SAS Enterprise Guide report window 
and select Print. If you view SAS Enterprise Guide reports in a browser, then use your 
browser print capabilities to print the report.  To print a report from the SAS 
Information Delivery Portal, also use your browser print capabilities. 

Stack Column Task (Reference 1) 
The Stack Columns task in SAS Enterprise Guide allows you to stack your data so 

that multiple columns of data can become multiple rows of data. This step is required for 
recreating certain charts and plots available in SAS IT Resource Management 2.7.  

The following example shows where two analysis variables will be stacked. 
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After you assign the variables to their appropriate task roles click on the Columns 
Naming window to change the default column labels for the new columns that will be 
created. Changing the column names and column labels is optional. However, changing 
the default column labels is recommended because they are very long and can cause 
unexpected errors for some graph types. 

 
 
 
For more information about working with the Stack Columns task, see 
SAS Enterprise Guide help. 
 

Custom User Code to Accumulate Stacked Data (Reference 2) 
The Stack Columns task in SAS Enterprise Guide allows you to stack your data so 

that multiple columns of data can become multiple rows of data. This step is required for 
recreating certain charts and plots available in SAS IT Resource Management 2.7.  

However, custom user code is also required if you also want to accumulate the data. 
This step is required for recreating stacked plots available in SAS IT Resource 
Management 2.7.  

You can add custom user code to the Stack Columns task by clicking Preview code 
and then clicking Insert Code. Your custom code must follow the RUN statement that 
follows the TRANSPOSE procedure code generated by SAS Enterprise Guide.  

The following image shows the User Code window. You can insert custom user code 
wherever an “insert code” icon appears. The “insert code” icon at the bottom of the image 
shows where you should insert your custom user code to accumulate your data. 
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The custom user code that is required to accumulate your data is a DATA step that 
accumulates the output from PROC TRANSPOSE. The next screen shot shows a code 
fragment that includes PROC TRANSPOSE and a DATA step for accumulating your 
stacked data.  

Note that when writing the DATA step, some information is derived from PROC 
TRANSPOSE. The following information is derived from PROC TRANSPOSE: 

 The data set name must equal the data set name associated with the OUT= 
parameter of PROC TRANSPOSE. 

 The list of BY variables must equal the list of BY variables of PROC 
TRANSPOSE. 

 The required variable for the FIRST function will be derived from the BY 
variable list of PROC TRANSPOSE. Which variable is selected determines how 
your data is accumulated. Use the following rules to determine which variable to 
select for the FIRST function: 

 If you want to accumulate analysis variables, as shown in Example 16 of 
Chapter 2, then select the last BY variable from PROC TRANSPOSE for 
the FIRST function of your DATA step.  

 If you want to accumulate a class variable, as shown in Example 18 of 
Chapter 2, then use the next to last BY variable from PROC TRANSPOSE 
for the FIRST function of your DATA step.  

The following example shows how to accumulate two analysis variables. 
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Overview 
The following sections discuss the means by which specific types of reports were 

created with SAS IT Resource Management 2.7 and the recommended means by which 
they are created using SAS IT Resource Management 3.1.1. 

Bar and Pie Charts 
The following table presents the eight chart types available in SAS IT Resource 

Management 2.7 and communicates the corresponding SAS Enterprise Guide task that 
is available to generate those chart types in SAS IT Resource Management 3.1.1. 

Table 2.1 SAS IT Resource Management 2.7 Chart Types and Corresponding SAS Enterprise Guide Tasks 

Chart Type SAS Enterprise Guide Task 

Vertical Bar Bar Chart task 

Horizontal Bar Bar Chart task 

Vertical Bar 3D Bar Chart task 

Horizontal Bar 3D Bar Chart task 

Pie Pie Chart task 

Pie 3D Pie Chart task 

Star Not supported 

Block Not supported 

In SAS Enterprise Guide, the bar orientations (vertical and horizontal) are task 
subtype options that are available in the bar chart task. The bar dimensions (2D and 
3D) are appearance options in the bar chart and pie chart tasks.  

This section presents more details of the SAS IT Resource Management 2.7 macro 
used to create various types of bar and pie charts and the equivalent SAS Enterprise 
Guide steps required to recreate these types of reports.   

In SAS IT Resource Management 2.7, the %CPCHART macro is used to create these 
three bar chart types: 

 one analysis column and one class column (Example 1) 
 one analysis column,  one class column, and one group column (Example 2) 
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 one analysis column, one class column, and one subgroup column (Example 3) 

The %CPCCHRT macro is used to create these four bar chart types: 
 multiple analysis columns (Example 4) 
 multiple analysis columns and one group column (Example 5) 
 multiple analysis columns, one group column, and one subgroup column 

(Example 6) 
 multiple analysis columns, one group column, and one stack column (Example 7) 

In SAS IT Resource Management 2.7, the %CPCHART macro is used to create the 
following pie chart type: 

 one analysis column and one class column (Example 8) 

The % CPCCHRT macro is used to create the following pie chart type: 
 multiple analysis columns (Example 9) 

The following sections show how to recreate the seven bar chart types and the two pie 
chart types using SAS Enterprise Guide. 

Bar Chart and Pie Chart Notes 
Here are some notes that you might consider when working with bar charts and pie 

charts: 
 The difference between bar chart Example 6 and Example 7 in SAS Enterprise 

Guide is in the column role assignments. 
 A future release of SAS Enterprise Guide will include a new bar chart task that 

will enable you to create bar chart Example 4, Example 5 and Example 6 without 
requiring the additional Stack Columns task.  

 Do not confuse the Group bars by role, available in some chart tasks, with the 
Group charts by role. The Group charts by role is a role that is available in 
most report tasks. It allows you to create a different report page for each value of 
the Group charts by column. 

 The Transpose task can be substituted for the Stack Columns task. See SAS 
Enterprise Guide help for more information about the differences between the 
Stack Columns task and the Transpose task. 

 The graph examples in the following sections typically show two analysis 
columns wherever multiple analysis columns are supported.  

 Some graph titles might refer to SAS IT Resource Management 2.7 terminology 
to help you make the transition from 2.7 to 3.1.1. For example, a class column 
assigned to a subgroup role in 2.7 might be assigned to a stack role in 3.1.1 to 
achieve the same results.  
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Example 1 

Bar Chart with One Analysis Column and One Class Column 
 

 
 

1 Select the Bar Chart task. 

2 Select the Simple Vertical Bar chart type. 

3 Assign one analysis column to the Sum of role. 

4 Assign one class column to the Column to chart role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 2 

Bar Chart with One Analysis Column, One Class Column, and One Group 
Column 

 
 

1 Select the Bar Chart task. 

2 Select the Grouped Vertical Bar chart type. 

3 Assign one analysis column to the Sum of role. 

4 Assign one class column to the Column to chart role. 

5 Assign one class column to the Group bars by role. 

6 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 3 

Bar Chart with One Analysis Column, One Class Column, and One 
Subgroup Column 

 
 

1 Select the Bar Chart task. 

2 Select the Stacked Vertical Bar chart type. 

3 Assign one analysis column to the Sum of role. 

4 Assign one class column to the Column to chart role. 

5 Assign one class column to the Stack role. 

6 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 4 

Bar Chart with Two Analysis Columns  
 
 

 
 

1 Select the Stack Columns task located in the Data category to transpose your 
data.  

2 Assign the two analysis columns you want to chart to the Columns to Stack role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role. 

4 Rename your new column labels (See Reference 1). 

5 Run the Stack Columns task to transpose your data. 

6 Select the Bar Chart task. 

7 Select the Simple Vertical Bar chart type. 

8 Assign the new transposed analysis column to the Sum of role. 

9 Assign the new transposed class column to the Column to chart role. 

10 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 5 

Bar Chart with Two Analysis Columns and One Group Column 
 

 
 

1 Select the Stack Columns task located in the Data category to transpose your 
data. 

2 Assign the two analysis columns you want to chart to the Columns to Stack role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role. 

4 Rename your new column labels (See Reference 1). 

5 Run the Stack Columns task to transpose your data. 

6 Select the Bar Chart task. 

7 Select the Grouped Vertical Bar chart type. 

8 Assign the new transposed analysis column to the Sum of role. 

9 Assign the new transposed class column to the Column to chart role. 

10 Assign one class column to the Group bars by role. 

11 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 6 

Bar Chart with Two Analysis Columns, One Group Column, and One 
Subgroup Column  

 
 

1 Select the Stack Columns task located in the Data category to transpose your 
data. 

2 Assign the two analysis columns you want to chart to the Columns to Stack role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role. 

4 Rename your new column labels (See Reference 1). 

5 Run the Stack Columns task to transpose your data. 

6 Select the Bar Chart task. 

7 Select the Grouped/Stacked Vertical Bar chart type. 

8 Assign the new transposed analysis column to the Sum of role. 

9 Assign the new transposed class column to the Column to chart role. 

10 Assign one class column to the Group bars by role. 

11 Assign one class column to the Stack role. 
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12 (Optional) Assign one or more class columns to the Group charts by role. 

Example 7 

Bar Chart with Two Analysis Columns, One Group Column, and One 
Stack Column  

 
 

1 Select the Stack Columns task located in the Data category to transpose your 
data. 

2 Assign the two analysis columns you want to chart to the Columns to Stack role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role. 

4 Rename your new column labels (See Reference 1). 

5 Run the Stack Columns task to transpose your data. 

6 Select the Bar Chart task. 

7 Select the Grouped/Stacked Vertical Bar or the Grouped/Stacked 
Horizontal Bar chart type. 

8 Assign the new transposed analysis column to the Sum of role. 
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9 Assign one class column to the Column to chart role. 

10 Assign one class column to the Group bars by role. 

11 Assign the new transposed class column to the Stack role. 

12 (Optional) Assign one or more class columns to the Group charts by role. 

Example 8 

Pie Chart with One Analysis Column and One Class Column  

 
 

1 Select the Pie Chart task. 

2 Select the Simple Pie chart type. 

3 Assign one analysis column to the Sum of role. 

4 Assign one class column to the Column to chart role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 

 



22 Example 9      Chapter 2 

Example 9 

Pie Chart with Two Analysis Columns 

 
 

1 Select the Stack Columns task located in the Data category to transpose your 
data.  

2 Assign the two analysis columns you want to chart to the Columns to Stack role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role. 

4 Rename your new column labels (See Reference 1). 

5 Run the Stack Columns task to transpose your data. 

6 Select the Pie Chart task. 

7 Select the Simple Pie chart type. 

8 Assign the new transposed analysis column to the Sum of role. 

9 Assign the new transposed class column to the Column to chart role. 

10 (Optional) Assign one or more class columns to the Group charts by role. 
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Line and Other Plots 
The following table presents the 15 plot types or options available in SAS IT Resource 

Management 2.7 and communicates the corresponding SAS Enterprise Guide task that 
is available to generate those chart types in SAS IT Resource Management 3.1.1. 

Table 2.2 SAS IT Resource Management 2.7 Plot Types and Corresponding SAS Enterprise Guide Tasks 

Plot Type SAS Enterprise Guide Task 

2XY Line Plot task 

Line Line Plot task 
Join Line Plot task 
Needle Line Plot task 
Smooth Line Plot task 
Spline Line Plot task 
Standard Deviation Line Plot task 
Step Center Line Plot task 
Percent Line Plot task 
Scatter Scatter Plot task 

Stack Area Plot task 

Stack Percent Area Plot task 

Box Plot Box Plot task 

Hi – Low plot Box Plot task 

Regression Various regression plots in the Analyze category of plots 

This section presents more detail of the SAS IT Resource Management 2.7 macro used 
to create various types of plots and the equivalent SAS Enterprise Guide steps required 
to recreate these types of reports.   

In SAS IT Resource Management 2.7, the %CPPLOT1 macro is used to create these 
types of line plots: 

 one analysis column and one class column (Line, Step, Box and Hi-Low Plots) 
(Examples 10, 11, 12 and 13) 

 multiple analysis columns (Scatter Plot) (Example 14) 
 multiple analysis columns and one class column (Line and Line Stack Plots) 

(Examples 15 and 16) 
 one analysis column, one class column, and one group column (Line and Line 

Stack Plots) (Examples 17 and 18) 

The %CPPLOT2 macro is used to create this type of line plot: 
 2XY Plot with Multiple Analysis Columns and One Class Column (Example 19) 

Here are some notes that you might consider when using line plots: 

 Do not confuse the Group role, available in some plot tasks, with the Group 
charts by role. The Group charts by role is a role that is available in most 
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report tasks. It allows you to create a different report page for each value of the 
Group charts by column. 

 The graph examples in the following sections typically show two analysis 
columns wherever multiple analysis columns are supported.  

Example 10 

Line Plot with One Analysis Column and One Class Column  

 
 

1 Select the Line Plot task. 

2 Select the Line Plot subtask. 

3 Assign one analysis column to the Vertical role. 

4 Assign one date or time class column to the Horizontal role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 11 

Step Plot with One Analysis Column and One Class Column  

 
 

1 Select the Line Plot task. 

2 Select the Step Plot subtask. 

3 Assign one analysis column to the Vertical role. 

4 Assign one date or time class column to the Horizontal role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 12 

Box Plot with One Analysis Column and One Class Column  

 
 

1 Select the Box Plot task. 

2 Select the Box Plot subtask. 

3 Assign one analysis column to the Vertical role. 

4 Assign one date or time class column to the Horizontal role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 13 

Hi-Low Plot with One Analysis Column and One Class Column  

 
 

1 Select the Box Plot task. 

2 Select the Hi-Low subtask. 

3 Assign one analysis column to the Vertical role. 

4 Assign one date or time class column to the Horizontal role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 14 

Scatter Plot with Two Analysis Columns  

 
 

1 Select the Scatter Plot task. 

2 Select any of the Scatter Plot subtasks. 

3 Assign one analysis column to the Vertical role. 

4 Assign one analysis column to the Horizontal role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 15 

Line Plot with Two Analysis Columns and One Class Column  

 
 

1 Select the Line Plot task. 

2 Select the Multiple vertical column line plots using overlay subtask. 

3 Assign two analysis columns to the Vertical role. 

4 Assign one date or time class column to the Horizontal role. 

5 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 16 

Stack Plot with Two Analysis Columns and One Class Column  

 
 

1 Select the Stack Columns task located in the Data category to transpose and 
accumulate your data. 

2 Assign the two analysis columns that you want to plot to the Columns to Stack 
role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role.  

4 Rename your new column labels (See Reference 1). 

5 Insert SAS Custom Code to accumulate your data (See Reference 2). 

6 Run the Stack Columns task to transpose and accumulate your data. 

7 Select the Area Plot task. 

8 Select the Multiple area plots by group column subtask. 

9 Assign the new transposed analysis columns to the Vertical role. 

10 Assign the new transposed class column to the Group role. 

11 Assign one date or time class column to the Horizontal role. 

12 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 17 

Line Plot with One Analysis Columns, One Class Column, and One 
Group Column 

 
 

1 Select the Line Plot task. 

2 Select the Multiple line plots by group column subtask. 

3 Assign one analysis column to the Vertical role. 

4 Assign one date or time class column to the Horizontal role. 

5 Assign one class column to the Group role. 

6 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 18 

Stack Plot with One Analysis Columns, One Class Column, and One 
Group Column  

 
 

1 Select the Stack Columns task located in the Data category to transpose and 
accumulate your data. 

2 Assign one analysis column you want to plot to the Columns to Stack role. 

3 Assign all of the class columns used in your report (including Group charts by 
columns) to the Group Analysis by role. Ensure that the class column that you 
want to accumulate in Step 5 in this task is the last column in the list. 

4 Rename your new column labels (See Reference 1). 

5 Insert SAS Custom Code to accumulate your data (See Reference 2). 

6 Run the Stack Columns task to transpose and accumulate your data. 

7 Select the Area Plot task. 

8 Select the Multiple area plots by group column subtask. 

9 Assign the new transposed analysis columns to the Vertical role. 

10 Assign one date or time class column to the Horizontal role. 

11 Assign one class column to the Group role. 

12 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 19 

2XY Plot with Two Analysis Columns and One Class Column 

 
 

1 Select the Line Plot task. 

2 Select the Line Plot subtask. 

3 Assign one analysis column to the Vertical role. 

4 Assign one analysis column to the Vertical (Right) role. 

5 Assign one date or time class column to the Horizontal role. 

6 (Optional) Assign one or more class columns to the Group charts by role. 
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Example 20 

3D Graph  
The 3D graph available in SAS IT Resource Management 2.7 differs from the 3D 

graph generated with SAS Enterprise Guide. In SAS Enterprise Guide, the columns for 
the horizontal, vertical, and depth task role must be numeric. In SAS IT Resource 
Management 2.7, a class column is supported. 

You can use the Line Plot task in SAS Enterprise Guide to generate a plot that shows 
all of the information available in the SAS IT Resource Management 2.7 3D graph.  
Refer to Example 17 to create this graph. 
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Tabular Reports 
 

The following table shows the six tabular report types that are available in SAS IT 
Resource Management 2.7 and lists the corresponding SAS Enterprise Guide task that 
is available to generate those report types in SAS IT Resource Management 3.1.1. 

Table 2.3 SAS IT Resource Management 2.7 Report Types and Corresponding SAS Enterprise Guide Tasks 

 Tabular Report Type SAS Enterprise Guide Task 

1 Analysis X Statistic Summary Tables task 

2 Class (value) X Analysis (Statistic) Summary Tables task 

3 Class (value) X Statistic (Analysis) Summary Tables task 

4 Class (value) X Analysis (Sum) Summary Tables task 

5 Class values X Class (Analysis (Statistic)) Summary Tables task 

6 Class values X Analysis (Statistic) Summary Tables task 

SAS IT Resource Management 2.7 uses the macro %CPTABRPT to create all of the 
variations that are shown in the preceding table. In SAS Enterprise Guide, you can 
create any of these variations with the Summary Tables task.  

The following examples show the report output and the Summary Tables task for each 
of the preceding variations. Follow these steps to create any of the reports in examples 
21–27.  

1 Select the Summary Tables task located in the Describe category of reports. 

2 In the Task Roles window, assign the analysis columns you want to include in 
your report to the Analysis columns task role. 

3 In the Task Roles window, assign the class columns you want to include in your 
report to the Classification columns task role. 

4 In the Summary Tables window, drag and drop the analysis columns and the 
classification columns to the appropriate section of the Box Area.  The second 
screen shot of each example below provides a guide for where to drop and drag the 
variables. 

5 (Optional) In the Task Roles window, assign one or more class columns to the 
Pages role. 
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Example 21 

Tabular Report Analysis X Statistic  
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Example 22 

Tabular Report Class (Value) X Analysis (Statistic)  
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Example 23 

Tabular Report Class (Value) X Statistic (Analysis)  
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Example 24 

Tabular Report Class (Value) X Analysis (Sum)  
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Example 25 

Tabular Report Class Values X Class (Analysis (Statistic))  
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Example 26 

Tabular Report Class Values X Analysis (Statistic)  
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Example 27 

Print Report  
SAS IT Resource Management 2.7 uses the macro %CPPRINT to create Print reports. 

In SAS Enterprise Guide, you can create a print report, known as a Listing Report, 
using the List Data task available in the Describe category of tasks. 

Follow these steps to create a Print report:  

1 Select the List Data task located in the Describe category of reports. 

2 In the Task Roles window assign the analysis columns and classification columns 
that you want to include in your report to the List columns task role. 

3 (Optional) In the Task Roles window assign one or more class columns to the 
Page by role. 
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Example 28 

Source Code  
SAS IT Resource Management 2.7 uses the macro %CPSRCRPT to submit SAS code 

that is stored in a catalog source file. In SAS Enterprise Guide, you submit SAS code by 
creating and submitting a Code task.   

Follow these steps to create a Code task to run source code: 

1 Select File > New > Code from the menu bar. 

2 Enter your SAS code in the Code window. 

3 Right-click the mouse and select Run to submit the code. 
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Dynamically Summarized Reporting  
A primary enhancement of SAS IT Resource Management 3.1.1 is that you can use it 

to perform all of the data transformations that are necessary to produce analysis and 
report-ready data before report generation time.  Using the SAS technologies that are 
specifically designed for data integration to prepare IT data for analysis and reporting 
will improve the performance of SAS IT Resource Management reporting and the 
system as a whole. 

In previously released versions of SAS IT Resource Management, the Performance 
Data Base (PDB) structure limited the solution to predefined time period 
summarizations.  In response, SAS IT Resource Management 2.7 reporting macros 
evolved to perform special time-based summarizations that were calculated at the time 
of report generation.  In SAS IT Resource Management 3.1.1, the IT data mart 
structure replaces the PDB and enables data to be summarized as desired by the user 
through the SAS IT Resource Management 3.1.1 staging and aggregation 
transformations. 

The SAS IT Resource Management Adapter Setup Wizard provides several of the 
summarized aggregations that were typically created at the time of report generation 
by SAS IT Resource Management 2.7 macros. However, you can manually create any of 
these summarized aggregations by using the guidelines in this section.  

SAS IT Resource Management 3.1.1 has an enhanced list of formulas to support SAS 
IT Resource Management 2.7 to SAS IT Resource Management 3.1.1 report conversion. 
By choosing class columns for your summarized aggregations that use these new 
formulas, you can create summarized aggregations that provide the equivalent dynamic 
summarization available in SAS IT Resource Management 2.7 reporting. 

The following table presents a list of SAS IT Resource Management 2.7 data 
summarizations that can be performed at the time of report generation.  It also 
illustrates the recommended formulas in SAS IT Resource Management 3.1.1 that 
make the concept of report time data summarization and manipulation obsolete.  

C H A P T E R  C H A P T E R  
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Table 3.1 SAS IT Resource Management 2.7 Report Summarizations and Corresponding Formulas in 3.1.1 

SAS IT Resource 
Management 2.7 

SAS IT Resource Management 3.1.1 

Reporting 
Summarization 

Class Column Formula for 
Summarized Aggregation Table 

Recommended 
Format 

As Is  Datetime  NLDATM18. 

15 Minute DatetimeFifteenMinute NLDATM13. 

Hour Hour and the appropriate Date type 
column such as DayDate, 
WeekDate, or MonthDate 

2. 

24 Hour TwentyFourHour NLTIME10. 

Date DayDate NLDATE10. 

Whole Day DayDate NLDATE10. 

Week Day DayOfWeek WKD. 

Month Day DayOfMonth 2. 

Year Day DayOfYear 3. 

Week WeekDate NLDATE10. 

Month MonthDate NLDATE10. 

Year Month MonthOfYear MON. 

Quarter QuarterDate NLDATE10. 

Follow these steps to create an aggregation table that includes in its class list a 
column using the formulas in the preceding table. Your aggregation table might include 
additional resource class columns.  

Note: This task demonstrates how to modify an existing staged table and an existing 
aggregation table. If you are creating a new staged table or a new aggregation table, the 
instructions are similar; however, you will be adding new tables instead of modifying 
tables. ∆ 

 

1 Start SAS Data Integration Studio and connect to the ITMS repository of your 
metadata server. 

2 Using the Custom Tree, find the staged table that you want to modify in the 
Staged Table folder of your IT data mart. (See the note that follows this task if 
you are not working with a staged table.) 

3 Add a new column to your staged table.  To do so, perform the following steps: 

a Double-click the table to open the Properties window. 

b In the Column tab, add a new column.  To do so, perform the following 
steps: 

i. Click New to create a new row. 

ii. Enter a name. 
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iii. Double-click the Expression column of the new row to reveal the  
ellipses button. 

iv. Double-click the ellipses button to open the Expression Builder 
window. 

v. Select the ITMS Formulas tab.  

vi. Select the desired formula from the formula list. 

vii. Click Insert. 

viii. Click OK. 

ix. Enter a description. 

x. Enter a format. (See the preceding table for a recommended format.) 

xi. Click OK to save the new staged table column. 

4 Using the Custom Tree, find and open the aggregation job that you want to 
modify in the Jobs folder of your IT data mart. 

5 Use the Process Designer window to add the new class column to your 
aggregation table.  To do so, perform the following steps: 

a Double-click the aggregation transformation to open the Properties window. 

b In the Aggregations tab, select the aggregation that you want to modify. 

c Click Edit. 

d Click Next until you open the Select Class & ID page where you can  
categorize the data. 

e Highlight the new column that you created in step 3 and add it to the 
Selected class variables window. 

f If your aggregation includes an unnecessary date-type column in the class 
list, then remove it from the Selected class variables window. 

g Click Next until you open the Specify variables to rank the data window. 

h Review the Ranked Grouping column for any necessary changes. 

i Click Next until you open the window titled Summarized aggregation table 
will be updated with the following details. 

j Confirm your changes by reviewing the information that you entered. 

k Click Finish to save your changes. 

l Click Yes to confirm your changes. 

m Click OK to close the window. 

6 Redeploy your aggregation job and submit the job so that the change will take 
effect.  Associated information maps that are created with the Information Map 
transformation will automatically reflect the new column. 

Note: Rerunning the Adapter Setup Wizard will not preserve the changes made in 
this section.∆ 

Note: If you are not working with a staged table, then you will not have access to the 
ITMS Formulas tab mentioned in step 3.b.v. in the preceding task. In this case you 
can cut and paste the expression from the desired formula. To access the expression, 
expand the Formulas folder located under the ITRMSoftwareTree in the Custom tab. 
Next double click on the desired formula and click on the Expression tab.∆ 
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Working with Migrated PDBs  
With few exceptions, column names and labels are preserved when migrating a SAS 

IT Resource Management 2.7 PDB to a SAS IT Resource Management 3.1.1 IT data 
mart. Therefore, user-written SAS code, that is not dependent on SAS IT Resource 
Management 2.7 macros, can be submitted to recreate existing reports with minimal 
changes. 

Here are a few tips for recreating existing reports: 
 The DATETIME column that was required in SAS IT Resource Management 2.7 

is no longer required in SAS IT Resource Management 3.1.1. In summarized 
aggregations, the columns DAYDATE, WEEKDATE, MONTHDATE, and 
YEARDATE are used instead.  

 Table names have changed. The level name is now appended to the original 
name. For example, a table with the original name SARDEV in the DETAIL 
library is now named SARDEV_DETAIL. 

 ITRM tables are now physical SAS datasets, by default, rather than SAS DATA 
step views. Code that requires views as input will not work.  

 Some column names changed. For example a COUNT column named PGFAULT 
is now called PGFAULT_RATE. 

For more details about these changes and for more information about migrating 
PDBs and working with migrated PDBs, see the SAS IT Resource Management 3.1.1 
Migration Documentation. 



Your Turn 

We want your feedback. 

• If you have comments about this book, please send them to 
yourturn@sas.com. Include the full title and page numbers (if 
applicable). 

• If you have comments about the software, please send them to 
suggest@sas.com. 
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